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1 Introduction

1 Introduction

SoilFluxProTM (SFP) software is a multi-platform application designed to view and analyze data
files for both chamber and continuous measurements generated by the LI-COR LI-8100A Auto-
mated Soil CO2 Flux System.

SFP offers a very convenient way to view selected quantities or summaries of these files, as
well as quickly plot meaningful analyses that let you evaluate the measurements. Editing and
recomputations are easily done.

........View file summaries.

Examine a curve fit

.

Group and plot data

.

Create .kml files

.

Surface analysis
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2 Introductory Tour

2 Introductory Tour

1. Launch SoilFluxProTM

When run, SFP presents you with an empty Main Window and three tool bars. For each LI-
8100A data file you open, this view will create a tab sheet for that file, and display a Summary
View.

....

Tool Bars can be dragged
around and/or detached

.

Tabs and Summary Views for
each file opened

2. Open a Data File
Normally, you would select ..File ..Open... and pick an LI-8100A data file. Note that there are
also several “built-in" sample files located under ..File ..Open Sample ; we’ll select the one named

..SampleSurvey.81x .

SFP 4.0 Page 4



2 Introductory Tour

3. The Summary View
Each observation in the data file is shown on one line in the summary view. In the example here,
10 observations from an LI-8100A with a survey chamber were read. Each observation is repre-
sented by one line, showing selected variables (Label, Obs#, etc.) from that observation.

...
Summary View

.

Action Log

4. Setting the Displayed Variables
The variables that are displayed for each observation are editable. Select ..View ..Display (or click
on ..Display ), to bring up the dialog for changing them.

....

Drag and Drop

.

Click and drag to add
items from the left list
to the right list. Also,
click and drag items
in the right hand list
to rearrange them. To
delete items from the
right hand list, high-
light them and click
the trash button. This
dialog is discussed in
more detail in Change
Displayed Variables.
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2 Introductory Tour

5. Zoom in on one Observation (Method 1)
We now illustrate how to view the details of an observation. Double click one of the observations
(lines) in the Summary View to open the Observation Details. In this view, we can see all the
header, measured, and footer variables. The window opened by double clicking “belongs" to
that observation; if you double click another observation, you get another window for that
observation.

.......Double Click .

The ..As Read and ..Current tabs pro-
vide text views of the observation.
The latter is editable; changes are
kept (with recompute) via ..Keep

.

The ..Recompute tab sheet provides
a more user friendly front end for re-
computing an observation

.

Each ..Fit tab shows the curve fit de-
tails for the observation, and provides
some tools and controls for tweaking
settings.
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2 Introductory Tour

6. Zoom in on an Observation (Method 2)
A second method for seeing details of an observation is to open the ..ShowDetails window. This
window does not belong to any one observation, but rather shows the first highlighted observa-
tion, or (if there are none) the first observation in the active summary view. You can use this
to quickly step through a series of observations viewing the curve fit, for example.

...

Always shows the first selected observation in the active view

....

Press ↓

.

Press ↓
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2 Introductory Tour

7. Make a Chart
Next, we will demonstrate charts. Click ..AddChart .

....

1. You are presented
with an empty plot
definition.

..

2. Click ..Favorites and
select
mykeySurvey Sequence.
The dialog should
change as shown
below.

..

3. Click ..OK to draw
the chart.

..

4. You can double
click anywhere on the
chart to bring back
the Setup Dialog.
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2 Introductory Tour

When the ..Observations setting in the setup dialog is ..Selected or All , and ..Auto update is checked, then
the chart will update anytime a selection change is made in the summary view, as illustrated
below

.....
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2 Introductory Tour

Suppose we want to superimpose the Cdry vs. time curves. Double click the chart to bring up
the setup dialog for it, and modify it like this:

...

1. Double click the
chart.

..

2. Change the bottom axis to
..Etime (elapsed time during
the observation - it lives in the
..Measured submenu).

...

3. Change the Cdry sym-
bol to ..none , and Style
to ..Lines .

.

4. Set grouping for both
variables to ..Observation .

.

5. Move the legend to
the right.

..

6. Click ..OK .
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2 Introductory Tour

Note that legend entries are clickable buttons: Click to make that entry disappear from the
graph, and click again to make it reappear.

...

Clickable buttons. Down = hidden, up = visible
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3 Summary View

3 Summary View

......

Create an Empty View

.

Open a File

.

Import from an LI-8100

.
Save a File

.

Export Data

.

Create a .kml file

.

Move Observations Be-
tween Views

.

Recompute Observations

.

Transform Columns

.

Remove Columns

.

Import Columns

.

Change Displayed Variables

.

Compute Statistics

.

Add a Chart

.

Observation Details
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3 Summary View

3.1 Open a File

SFP can read both Chamber and Continuous measurement types. Both measurement types can
reside within the same file, regardless of the extension type (.81x, .csv).

..

1. Click ..Open on the tool bar, or select it in the File Menu.

....

2. Use the Open file dialog box to
navigate to the desired directory,
and select the file(s) to be opened.

.

To select multiple files, use ..ctrl
+ click ( ... + click on Mac) to
select individual files, or ..shift +
click to select a range.

.

Note that SFP can read both .csv
and .81x file types.

.

3. If multiple files are selected when you click ..Open ,
you are given a choice of combining them all into one
view or keeping them separate.

...

When multiple files are combined,
each observation retains its original
File Name.

.

Item# indicates the order of the
observation as read from the file.
Type indicates the type of data,
Chamber or Continuous.

.

The illustration to the right
combines three files into one
view.

.

1

.

2

.

3
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3 Summary View

3.2 Import Data From an LI-8100A

SFP can read data files directly from an LI-8100A.

..

1. Click ..Acquire on the tool bar, or select it from the File
menu.

...

2. Specify IP address if using Ethernet, or select the comm port
if using RS-232.

...

3. Click ..Connect to LI-8100A . You should get a file list.

..

Try this if the list doesn’t
appear.

.

If the LI-8100A just pow-
ered up, the pump may
be running. This will
stop it.
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3 Summary View

...

4. Select the file(s) to down-
load.

.

5. Specify the destination
directory.

.

6. Click ..Download .

.

Deletes selected files on
the instruement.

..

The download in progress.
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3 Summary View

3.3 Save a File

Select ..File ..Save... , or click ..Save on the tool bar.
......

Controls the delimiter character, and the default
file suffix (used only if you don’t type one).

3.3.1 File Suffixes

You can type any suffix (e.g. .81x, .txt, .junk, etc.) that you wish on the file name. If you leave
a suffix off, the program will automatically append the one showing in the filter box. However,
the type of file that is written is determined by the filter box setting.

3.3.2 File Delimiters

The save dialog filter box also determines what delimiter character is used when the observations
are written. Note that SFP can read files with any combination of continuous or chamber
measurements with any of these delimiters: tab, comma, or semi-colon. Delimiters must be
consistent within an observation, but can be different from one observation to the next within a
file. When SFP writes files, however, it will use a consistent delimiter throughout the file.
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3 Summary View

3.4 Export Data

Summary-style data (one observation per row) can be written to a text file, for input to spread-
sheet or text editing applications.

..

1. Click ..Export , or select it from the File menu.

...

2. Select the fields to export. These can be the same as the
Summary View, or you can define a different set.

..

Export a different set of variables. Click
..Define... to set (see Selecting Variables Di-
alog).

..

3. The results can be saved to a file, or copied to the clipboard
for pasting into other applications.

3.5 Change Displayed Variables

..

1. Click ..Display , or select it from the View menu.

...

2. The Selecting Variables Dialog (next) is used for this.
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3 Summary View

3.5.1 Selecting Variables Dialog

Any time a list of variables needs to be defined, such as when selecting variables to display in
the Summary View, or selecting variables to print or export, the following dialog is used:

...

Drag and Drop

.

Read/write right-hand
list from/to a file.

.

Remove selected items
from list.

.

The list of potential variables is divided into 4 lists: Header (above), Footer,
Measured, and Miscellaneous (below).

.....

Footer Items. ..Gas #
refers to which flux col-
umn to use. Usually this
is 1. If you add flux com-
putations, there will be
more columns.

.

Measured Items. You can
select IV (initial value),
Mean or Range.

.

Miscellaneous items.

More information about the structure of LI-8100A files and what these variables are can be
found in SFP Definitions.
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3 Summary View

3.6 Move Observations Between Views

Selected observations in the Summary View can be Copied, Cut, and Pasted. Observations are
selected by clicking on them. Note that ..ctrl + click (or ... + click on Mac) selects multiple
observations, and ..ctrl + click selects a range of observations. See also Create an Empty
View.

...

3.7 Create an Empty View

Sometimes it is useful to create an empty view, such as to create a destination for observations
that you will paste in from other views (Move Observations Between Views). Creating an empty
view is done by selecting ..New from the File menu or tool bar.

.....

New tab sheets are
titled “unnamed".
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3 Summary View

3.8 Sort Observations

Click on the column header you wish to use for sorting. Click again to change sort direction.
...

1. Enable sorting by right click-
ing in the content area of a
Summary View.

..

2. When sorting is enabled, you
can sort by a column by click-
ing in that column’s header.

.

To reverse the direction of sort,
click again in the header.
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3 Summary View

3.9 Add a Chart

Click ..AddChart , or select it from the View menu.

.....

Click here to add a
vertical axis...

.

... then here to de-
fine the horizontal
axis...

.

...or click here and
select from a list of
pre-defined graphs.

.

Defining the variable associated with a vertical or bottom axis is done as shown:
...

1. Use the drop down menu
to select the variable. Most
are grouped in submenus.
Here, we are selecting Date.

..

2. Items from the Measured
menu have a secondary se-
lection: IV, Mean, and
Range have one value per
observation, while the All
selection refers to all of the
Type=1 values.

..

Footer items also have a sec-
ondary selection, although
it is usually 1. If you have
added more flux computa-
tions, then this is how you
get to them.
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3 Summary View

The vertical axis definition includes which variable to plot, which axis, symbol, curve type, and
grouping information.

.......

3.9.1 How to Group Plotted Data

To illustrate grouping, we will use a data file with four multiplexed ports. (If you wish to follow
along, use ..File ..Open Sample ..SampleMultiplex.81x . The first graph shows flux as a function of time,
with no grouping.

.....

No grouping, so all observations are
lumped into one category: the variable
being plotted.

SFP 4.0 Page 22



3 Summary View

Next, we do a simple grouping by observation.
.....

When grouped by observation,
each observation appears in a
different color, and as a sepa-
rate entry in the legend.

Grouping can also occur via one or more tests. In this next example, we examine Port#,
treat them as integers, and combine data sets with like port numbers together, naming them
“Port=”.

.....
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3 Summary View

Finally, we combine the data into two groups: between rows and within rows, based on the Label
in each observation.

....

We define two tests here.

...

Test 1: If Label contains the word
within, put it in this group.

.

Test 2: If Label contains the word
between, put it in this group.

.
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3 Summary View

3.9.2 Setting the Color Sequence

The sequence of colors used in Charts is automatic, but you can modify that sequence with the
Color Sequence Dialog.

....

To rearrange items, click
and drag. Double click to
edit a color.

..

Adding or editing
an entry uses the
system color picker
dialog.

.
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3 Summary View

3.10 Create a .kml File for Google Earth

If GPS data is contained in the observation, then a .kml file can be created. The following
example uses the file ..File ..Open Sample ..SampleMultiplex.81x .

..

1. Click ..Map on the tool bar, or select it from the File menu.

....

2. Check the observations
to be included. This list will
only show observations that
have Latitude and Longitude
data.

.

3. Select which sorts of
markers you wish to have
drawn.

.

3. Select how the data
should be grouped.

..

This list is user definable. To
edit a definition, highlight it
and click ..View/Edit Details... .

.
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3 Summary View

....

a) Single marker (merged obser-
vations) showing average loca-
tion of all 10 observations.

...

b) To put a marker at each ob-
servation, do not merge them.

...

c. Each obs location marked
with a 3D column, height pro-
portional to flux.
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3 Summary View

With continuous measurement (for example, ..File ..Open Sample ..SampleMapper.csv ), the Path marker
is probably the most interesting to use.

...

The 3D path has a height (m) that is
computed from the CO2 concentration
at each point minus 350.

.
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3 Summary View

3.10.1 Group by Observation or Marker

The following illustrates the difference between the option to group by observation, and group
by marker.

....

There’s a column check box, and a marker check
box. Under each are 10 check boxes for each obser-
vation location.

...

Each of the 10 observations has a check box, and
under each is a check box for the column and one
for the marker.
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3 Summary View

3.11 Compute Statistics

..

1. Click ..Statistics , or select it from the View menu.

...

2. Pick the list of variables on which to compute
statistics. It can be the same as the Summary View
list, or you can pick a different set (SelectingVariables
Dialog).

..

3. Click ..OK , and the results will be shown in a window. This summary table can
be saved as a text file, or printed.

..

..Save allows you to write the contents
with tab delimiters to a text file.

.

..Copy to clipboard puts this content into the sys-
tem’s clipboard, allowing you to paste it into other
applications, such as spreadsheets.
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3 Summary View

3.12 Recompute Observations

..

1. Click ..Recompute , or select it from the Edit menu.

...

2. In the Recompute Dialog, select the thing(s) you
wish to change. In the example below, we are chang-
ing the Offset (collar height parameter), which will
change the total volume, and thus the flux.

..

If you wish to redo the curve fit, or set all the
start/stop times the same, you can check the ap-
propriate boxes in the..Flux Calculations area.

.

3. Click ..OK , and the observa-
tion(s) will be recomputed, and
the results displayed in a sum-
mary window.

.
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3 Summary View

3.12.1 Recompute Options

The figure below indicates the various options available when recomputing.

...

Changing any of these constants
will change the total volume,
and thus the flux.

.

Redo the Cdry vs. Etime curve fit.

.

You can specify the column to use
for chamber air temperature.

.

This is only necessary if
you eliminated some raw
records from the observa-
tion.

.

Fluxes of additional Gasses.

.

Adjust start and
stop times for the
curve fit.

.

Dilution correction
is not an option
for Cdry, since it is
already corrected.

.

See Compute Tar-
geted Flux

3.12.2 Compute Targeted Flux

The LI-8100A computes flux at the concentration present when the chamber closed. SFP sup-
ports additional flux computations at other targets based on the slope of the exponential fit of
Cdry vs. Etime. To compute the rate of change of Cdry at a particular target concentration Ct,
we first solve the Exponential Fit expression for time tt such that C(tt) = Ct. Since

Ct = C∞ + (C0−C∞)e−a(tt−t0) (1)
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3 Summary View

tt =
1

a
ln
C0 − C∞

Ct − C∞
+ t0 (2)

The rate of change of Cdry at time tt is then

δ

δt
C(tt) = a(C0−C∞)e−a(tt−t0) (3)

Targeted flux is computed using this slope. The target can be a user entered value (Target),
and the flux at this value is Flux@Target. SFP also computes the minimum Cdry value during
chamber closing (MinCO2), and the flux at that target value (Flux@Min). Target can be specified
in the Recompute Observations dialog.

3.12.3 Fluxes of Additional Gasses

The LI-8100A computes flux for Cdry, the water corrected CO2 concentration. You can add
additional fluxes for other gasses that are recorded during the measurement (e.g. use H2O or use
signals from an external gas analyzer that were recorded by the LI-8100A in a spare channel).
See Footer for where the results reside.

...
1. To add a flux compu-
tation, click ..+ . .

2. Specify the column
label for the data to be
used for this gas. If you
had methane data logged
in V2, then you would
use that. In this figure,
we are using the H2O
column to compute a wa-
ter flux.

.

3. If the data needs to be corrected
for water vapor, specify the column to
use for water vapor (typically H2O).
Also, specify how to convert the wa-
ter data in that column to units of
mol/mol. (If you used H2O, which is
in mmol/mol, then the multiplier is
0.001.

.

4. If you want a targeted flux value,
specify the target here.
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3 Summary View

3.13 Transforming Columns

The measured data columns can be can be mathematically transformed, using one of the follow-
ing:

Z = a(X + b)

Z = aX + bY + c

Z = a(X + b)(Y + c)

Z = a
X + b

Y + c

Z = a+ bX + cX2

Z = a+ bX + cX2 + dX3 + eX5 + fX5 + gX6

(4)

where Z are the values in the column to be transformed, a, b . . . g are user entered constants,
and X and Y are also column values (can be same as Z), but can also be any other value in the
observation.

To do a column transform, click ..Transform on the tool bar or ..Edit ..Column ..Transform... .

........

This example creates a new column named T_avg
that is the average of columns T1 and T2
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3 Summary View

The ..Preview button applies the transform to the first file in the potential list and shows the
results in a view; it does not change the observational data.

...

3.13.1 Soil Moisture

There are three “built-in" soil moisture transformations. Decagon_EC-5 uses a 3rd order poly-
nomial, and the two DeltaT_ML3 transforms use a 6th order polynomial. Coefficients shown
below.

Name a b c d e f g
Decagon EC-5 -0.612 1.16 -0.314 - - - -

DeltaT ML3 (Mineral) -0.071 0.735 0.75 -8.759 21.838 21.998 8.097
DeltaT ML3 (Organic) -0.039 0.802 0.819 -9.556 23.823 23.997 8.833
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3 Summary View

3.14 Importing Columns

Data collected and stored in a separate file by another gas analyzer running in parallel with
the LI-8100A can be imported into the LI-8100A data file, and fluxes computed from it. The
methodology is to scan the external file(s) for the observations needed based on the time stamps
in the LI-8100A file. The figure below illustrates the process.

.....

Consider the first
observation in an
LI-8100A data file.

.

For each reading in the ob-
servation, we look in source
file(s) for corresponding
readings to get the appro-
priate value to import for
that reading.

.

For example, the LI-8100A
record at 09:28:55 would
import selected columns
from the external file from
a Los Gatos Research in-
strument, interpolated
from its 09:28:54.003 and
09:28:55.039 records

.

Im
po

rt
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3 Summary View

To import columns of externally collected data, click the ..Column Import tool bar button.

...

....

Step 1. Select the file format of
the source file(s).

.

Step 2. Add the source file(s) to
the list.

.

The label line and first ob-
servation from the first file
in the source list.

.

The expected format for an
LGR file. ok means that for-
mat was successful, while
Error means that format was
not successful.

.

The list of data columns
found in the first source file,
when parsed according to
the above expected formats.

.

Step 3. Check the columns you wish to import. Note that column(s) used
for time and date are shown here, but are not checkable.
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3 Summary View

Once the columns are imported, you can view them in the summary view, plot them, or use
them to compute fluxes.

...

Imported columns in the
Display Editor. Drag to
add them...

.

...to the Summary View.

.

Drag & Drop

...

Use the Recompute Dialog to
add flux computations based on
the imported columns
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3 Summary View

3.15 Removing Columns

To remove columns from observations, click on ..Remove , or else select it from ..Edit > Column > Remove... .

....

Check the names of the columns you wish to remove
from the observations, and click ..OK .

.

Note: There is no “undo" for this.

.
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4 Observation Details

4 Observation Details

To see Details for an observation, double click on that observation in Summary View. This opens
a view that “belongs" to that observation, updating automatically whenever something changes
in that observation (e.g. recompute). Alternatively, click ..Detail View , and see the detail view of
whatever observation happens to be highlighted in the active Summary View. Confused? See
Zoom in on one Observation (Method 1) and Zoom in on an Observation (Method 2).

...

As Read is a read-only
text view of the observa-
tion as it was last read
from a file. .

Current is an editable
view of the observation in
its current state.

.

Measurements shows raw
and summary records in
a table.

.

Recompute this
observation.

.
Fit #1 Cdry shows
curve fitting details.
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4 Observation Details

4.1 Current

The ..Current tab shows the observation in text form in its present form, including any changes
due to recomputations, column transformations, etc. This view is editable, so any sort of editing
is possible. ..Keep will rescan the text, just as if it were reading from a file. This does not change
the original view, so any changes you make (as well as any recomputations, etc.) can always be
undone by clicking ..Revert to Original .

..

To change Area, Volume, and/or Label for multiple observations all at once, see Recompute
Observations.
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4 Observation Details

4.1.1 Warnings and Messages

Warnings can be generated by the LI-8100A during the measurement; these are stored in records
whose Type is -1. They were put into the file at the time measurements were taken, and typically
say something about a measurement condition, such as high humidity, or the measurement was
restarted, etc. In addition, SFP itself can generate messages at the time an observation is read,
and the list of SFP’s messages are shown below.

..

SFPMessage Explanation

File Name: missing from header The label FileName was not found, but
subsequent records were.

ERROR: Failed to find measured
data labels

The line that identifies measured
columns Type Etime Date... was miss-
ing.

Old version. Updating format The original file is an older version for-
mat.

Adjusting dead band and
Crv_Domain...

This would typically be caused by all or
part of the observations footer missing.

Warning: Chamber never closed? Elapsed times never reached values >0.

Summary Records and Footer not
found

The file ended without any summary
records or footer.

Footer not found No footer was found in the file.
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4 Observation Details

4.2 Measurements

4.2.1 Text

The Measurement tab sheet shows all of the raw records for this observation under the Text
tab.

....

The IV, Mean, and
Range records are at
the bottom.
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4 Observation Details

4.2.2 Surface

For Continuous measurements that have GPS data, the Surface tab allows spectrographs and
contours to be plotted on the surface of your choice.

...

Which data col-
umn to plot.

.

Min and Max of
intensity scale.

.

# Grid lines used
each dimension.

.

Determines color
map transition
points.

..

R

.

G

.

B

.....

# contour intervals be-
tween Min and Max.

.

Resulting contour
spacing in units of
plotted variable.
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4 Observation Details

Note the partition control below: sliding it to the left will cover the setup controls.

...
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4 Observation Details

The ..Clone button will make a standalone window out of the surface graph and controls. The
cloned window retains all the controls except being able to change the variable that is plotted.
The window is also autonomous from the observation or its detail window that created it. If
you delete the source observation from a view, the detail window also goes away, but not this
cloned view.

...

Using clones can let you compare multiple variables from the same observation.

..
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4 Observation Details

4.3 Recompute

The Recompute tab in the Detailed View provides a mechanism to recompute just the target
observation. The interface is very similar to that provided in Recompute Observations; the only
difference is that from here, the recomputation is focused on one particular observation.

..
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4 Observation Details

4.4 Curve Fit Details

The Fit tab in the Observation Details view provides a close look at the exponential and linear
fits for an observation.

4.4.1 Changing Start/Stop Times

Click and drag the green Start (left vertical) line, or the red Stop (right vertical) line. When you
release the mouse button, the data between the lines are linearly and exponentially fit, and the
results shown in the grid above the chart. This doesn’t actually change the observation, unless
you click ..Keep .

...

Undo changes you
have made here,
since the last ..Keep
.

.

Save changes you
have made here.

.

You can also set
Start and Stop
with these con-
trols, then click

..Compute .

.

Start

.

Stop
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4 Observation Details

4.4.2 Manually Set C0

Co, the starting value of Cdry, is usually determined from the IV value of Cdry. You can man-
ually override this by checking the ..Manually Set Co check box, and clicking and dragging the blue
horizontal line to the desired value. This normally is not necessary, but is available for strange
data sets such as is shown below.

....

Check the box, then click and drag
the blue line.

The figure is typical of non-standard chambers that do not close, so sampling begins immedi-
ately, resulting in a “catch up" period. The software picked a value for Co of 659.8 (the blue
line, left figure). The right hand figure has the ..Manually Set Co box checked, and the blue line has
been dragged up to a more reasonable-looking value of 950.

Manually set Co values are marked with an asterisk, as seen above and in the Footer.

..
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4 Observation Details

4.4.3 Start/Stop Guidance

The Guidance tab provides some automated tools for assessing start and stop times.

.....
The ..Start Analysis plot
shows Flux as a function
of Start time (given the
current Stop time).

.

The ..Stop Analysis plot
shows Flux as a function
of Stop time, given the
current Start time.

.

The ..SlopeAnalysis
shows the slope of an ex-
ponential fit of data in a
moving band between the
current Start and Stop
times. In general, you
try to work in the region
where this changes lin-
early with CO2.
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5 Miscellaneous Topics

5 Miscellaneous Topics

5.1 LI-8100A Data File Format

5.1.1 Chamber Measurements

LI-8100A chamber measurement files consist of lines of tab-delimited text that constitute one
or more Observations. One observation is illustrated below:

...

Header

.

Raw Records

.

Summary Records

.

Footer

Header. The lines from LI-8100A: through Labels_01:.

Raw Records. A record of Type = 1. These represent measured data from the time the cham-
ber starts to close, to the when it starts to open.

Type Description
-1 Warning Record
1 Raw Record

2 Initial Value (Regressed from first 10
seconds of ETime>=0 data))

3 Mean Value (of ETime >= 0 data)
4 Range Value (of ETime >= 0 data)

Summary Records. A record of Type 2, 3, or 4. An Observation has one of each.
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5 Miscellaneous Topics

Footer. The results of the analysis, including flux values. The footer won’t be present for
files logged with the Compute Flux option off, or for Version 1 files (below). However, SFP will
regenerate the footer.
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5 Miscellaneous Topics

5.1.2 Footer

The footer contains the calculations for an observation. SFP adds multiple flux capability, and
these computations add some items to the columns found in the footer. In the example below,
there is one extra column [CH4]_ppm and two extra rows ( GasColumnID and Dilution). This
indicates that an extra flux computation was done, using an imported column, and it used the
LI-8100A’s water measurement H2O for the dilution correction.

..
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5 Miscellaneous Topics

5.1.3 Continuous Measurements

LI-8100A Continuous Measurement data files consist of lines of comma-delimited text, as is
illustrated below:

...

...

.

...

.

...

.

...

.

...

.

...

.

...

.

...
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5 Miscellaneous Topics

5.2 SFP Definitions

SFP classifies the variables in LI-8100A files into three types: Header, Measured, and Footer,
and adds a fourth type, Miscellaneous.

5.2.1 Miscellaneous Variables

Miscellaneous variables are not produced by the LI-8100A, but are added by SFP.

Label Description

Item#

When a file is read, observations are assigned values
starting with 1. They retain this number throughout
their life loaded in SFP, even if observations are sorted,
copy-pasted, etc. This value is not retained when a view
is written to a file; when that file is read, Item# values
are again assigned based on the order observations are
read.

Type Cham if a chamber measurement, or Cont if a continu-
ous measurement.

#Msgs
The number of Warnings and Messages. Warnings are
-1 TYPE records found in the data. Messages may be
generated when SFP reads the file.

#Raw Number of Type 1 records in the observation.

#Gasses
Number of gasses for which flux computations have been
done. That is, the number of data columns in the footer.
See Version 3.2 Footer.

ObsDateTime Equivalent to the Date value of the record having ETime
= 0.

ObsDateTime Day of the Year (fractional) of ObsDateTime.

ObsDecHr Decimal hour of the day of ObsDateTime.

HasGPS? Yes if there are GPS columns (at least Latitude and
Longitude) in the raw and summary data.
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5 Miscellaneous Topics

5.2.2 Header Variables

Header variables are in the header of files produced by the LI-8100A.

Label Description

LI-8100
5 hexidecimal values giving the size of the header, label,
raw data, summary data, and footer. This is not used
by SFP.

File Name

The original file name (as stored on the LI-8100A) is
preserved by SFP, regardless of how you may rename
the Windows files that contain this data, or cut and
paste observations.

Instrument Name

Serial Number

Software
Version of the embedded code in the instrument. If the
file has been stored by SFP, this field will also contain
the SFP version.

Comment User entered at time of data collection.

Obs# Observation number.

Port# Multiplexer port number. (0 if not using a multiplexer.)

Label User entered at time of data collection.

Observation
Length The original observation length.

Observation Delay Wait time between observations. (Renamed in version
3 to Prepurge.

Pre-purge Wait time before observations (named Observation De-
lay in v.2).

Post-purge Wait time after observations (new in version 3).

IRGA Averaging Averaging time for the gas analyzer.

Chamber Model identifier for the chamber used.

TSource Which channel to use for temperature for flux compu-
tations.

Flow8100 Pump setting in the LI-8100A box.

FlowMux Pump setting in the multiplexer box.

Tmux Multiplexer temperature at start of observation

Virga Volume of the IRGA (cm3)

Vmux Volume of the multiplexer (if used) (cm3)

Vext Volume of extension tubing (cm3)

Continued on next page
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Header Variables, Cont’d

Label Description

Vcham Volume of the chamber (cm3)

Offset Offset (cm) used in volume calculation

Area Exposed soil area (cm2)

Vtotal Total volume (cm3)

V1..V4 Info Information on how the voltage channel is configured:
Multiplexer channel, slope, offset, etc.

T1...T4 Info Thermocouple type information.

Labels_01 Number of columns in the raw data section

5.2.3 Measured Variables

Summary statistics of measured variables are identified by the column label, and a prefix of IV,
Mean, or Range. Thus, for example IVCdry means the Type 2 value of the Cdry column, and
Range Etime means the Type 4 value of the Etime column.

5.2.4 Footer Variables

The table below describes the Footer variables.

Label Description

CrvFitStatus

Curve fit solution. Exp means the exponential fit was
better than the linear fit (Exp_SSN < Lin_SSN). Lin
means the linear fit was still better after the maximum
number of iterations, and the nonlinear coefficients have
therefore been derived from linear fit.

Exp_Flux Flux computed from Exponential Fit.

Exp_FluxCV Coefficient of variance (%) of Exp Flux.

Exp_dCdry/dt Slope of the Exponential Fit at time t0.

Exp_R2 Correlation coefficient for Exponential Fit.

Exp_SSN Normalized sum of squares of residuals for Exponential
Fit.

Exp_SE Standard error (%) of the Exponential Fit.

Exp_a The a term in the Exponential Fit.

Exp_Cx The C∞ term in the Exponential Fit.

Continued on next page
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Header Variables, Cont’d

Label Description

Exp_Co
The C0 term in the Exponential Fit. Usually the IV
value of Cdry, but if followed by ∗ , indicates it has
been manually set. See Manually Set Co.

Exp_t0 The t0 term in the Exponential Fit.

Exp_Iter Number of iterations used in the Exponential Fit.

Exp_MaxIter
Maximum number of iterations allowed for the Expo-
nential Fit. This is fixed to 10 in the LI-8100A, but can
be adjusted in SFP.

Lin Flux Flux computed from Linear Fit.

Lin_FluxCV Coefficient of variable (%) of Lin Flux

Lin dCdry/dt Slope of the Linear Fit.

Lin_R2 Correlation coefficient for the Linear Fit.

Lin_SSN Normalized sum of squares of residuals for Linear Fit.

Lin_SE Standard error (%) of the Linear Fit.

Crv_Domain Time span (s) used in the curve fit.

Crv_#Smp Number of data points used for curve fitting.

Dead Band Time (s) after the chamber closes that are skipped by
the analysis, in the latest (re-)computation

TimeClosing Time (s) it took the chamber to close.

The values below are not part of an LI-8100A data file as output by the
instrument. They are, however, added to the footer of files saved by SFP.

GasColumnID The column label for which flux is computed. The first
one will always be Cdry.

Dilution

The column label used for the H2O measurements if a
dilution correction is applied to the GasColumnID flux
computation. When computing flux for Cdry, this is
none, since dilution is already accounted for in Cdry.
If a column label is specified, it will be followed by a
decimal value, that represents what was used to convert
the value in the water column to units of mol/mol.

Target See Compute Targeted Flux.

Flux@Target Flux at Target (Compute Targeted Flux).

MinCO2 Minimum CO2 during chamber closing.

Flux@Min Flux computed at the Minimum CO2 value.
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5.3 Curve Fitting Details

The LI-8100A (and SFP) fit measured variables Cdry vs. Etime in two ways: the traditional
linear fit, and the theoretically more correct exponential fit.

Linear Fit. Dilution corrected CO2 (C) is plotted against time in seconds (t) and fit by linear
regression.

C(t) = mt+ b (5)

where slope m is reported as Lin dCdry/dt. Offset b is not reported. The correlation coefficient of
this fit is reported as Lin_R2. The CO2 flux based on this rate is reported as Lin Flux.

Exponential Fit. Dilution corrected CO2 (C) is plotted against time in seconds (t) and fit
by a nonlinear regression.

C(t) = C∞ + (C0 − C∞)e−a(t−t0) (6)

C0 is the starting concentration, and is known (Type 2 value of Cdry). It is also the theoretical
concentration when t = t0. The nonlinear regression solves for C∞ , t0, and a, which are reported
as Exp_Cx, Exp_a, and Exp_t0 respectively. The correlation coefficient of the fit is Exp_R2, the
slope at t = t0 is Exp_dCdry/dt, the standard error of this slope is Exp_SE, the CO2 flux based
on this slope is Exp_Flux, and the coefficient of variation of this flux (in %) is Exp_FluxCV.

The data sets are the same for both fits, and is some subset of the Raw Records. There is a dead
band (DeadBand) of user-defined length to allow for complete mixing in the just closed chamber
(SFP labels this value to as ..Start time). The LI-8100A uses all of the raw records after the start
time slash deadband, but SFP allows you to shorten this by specifying a ..Stop time. How much
data was fit (number of seconds) is available as Crv_Domain, and Crv_# Smp is the number of
data points.

Exp_Iter reports the number of iterations that the nonlinear regression took, which typically is
less than 5. If the regression takes the maximum number of iterations (Exp_MaxIter - set via
Recompute) and still hasn’t converged, then the normalized sums of the squares of the residuals
are compared (Lin_SSN and Exp_SSN) to see which gave the better fit. CrvFitStatus reports the
result as Lin or Exp. Exp means the nonlinear fit had lower residuals than the linear fit, and Lin
means the linear fit was better. Whenever Lin is reported, note that the nonlinear coefficients
are set as follows, based on the linear fit:

C∞ = 1× 106

t0 =
C0 − b

m

a =
m

C∞ − C0

(7)

Lin usually indicates something strange with the data, caused by gusty conditions, a poor cham-
ber seal with surface, excessive DeadBand, etc..
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5.4 Preferences

The Preferences Dialog allows you to modify the tool bar appearance.
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